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EinfUhrung der neuen LA GARD

700er-Serie

Mit der EinfUhrung der neuen Tresorschlésser der LA GARD 700er-Serie verschlanken wir das Portfolio an

Eingabeeinheiten.

Die Optionen fur Eingabeeinheiten umfassen nun: Display, Bluetooth und verléngerte Batterielebensdauer.

LG Basic

39E, 66E, Supra,
3000, 3125, 5750
und 5750-K

3125, 5750-K,
66e mit Doppel-
berechtigungs-

nachweis

SmartLinc i

LA GARD 701
oder 700 LG
Basic

LA GARD
702/702D

LA GARD 703 mit
BLE-Batch

LA GARD 705



700er-Serie
Modell 700 Basic — Technische Daten

Modell: 700 Basic

Tastatur mit OLED-Display Nein Codelénge 6 Ziffern
Kompatible Schlosstypen Schwenkriegel/Sperrriegel -I:?::::;:u:‘li:beleuchtung Ja

Anz. Benutzer 1Manager/1 Benutzer Riegelschaltkontakt-Option* Nein
Anz. Schlésser 1 Manipulationssperre Ja
Super Master Reset Code Ja Batterieversorgung 2x9V
Vieraugen-Prinzip Nein Signal bei schwacher Batterie Ja
Umgehung des Vieraugen- Nein Warnung bei kritisch niedrigem Ja
Prinzips Batteriestand

Riicksetzfunktion Ja Zusdtzliches Netzteil Ja
Zeitverzégerung Nein Tastatur in flacher Ausfiihrung  Nein
Bestdtigungsfenster Nein Zeitplan fir Zeitsperren Nein
:J:I'l)%e)hung der Zeitverzogerung Nein Doppelberechtigungsnachweis Nein
TDO mit BLE-Batch Nein UL 2058 - UL Typ 1 Ja
Programmierbar tGber Tastatur  Ja VdS 2396 - Klasse 2 Ja
Programmierbar tber PC Nein EN1300 - Stufe B Ja
Priifereignisse Nein SBSC - 3880:2015 Ja
Anzeigbares Priifprotokoll Nein CNPP a2p — Stufe B/E Ja
Herunterladbares Priifprotokoll  Nein Gewdhrleistung 2 Jahre ab Herstellungsdatum
Bedrohungsalarm Nein Aktualisierbare Firmware Ja




LA GARD 700er-Serie
Haufig gestellte Fragen (FAQ)

Modell 700 Basic

Hinweis: Die Tastatur und das Schloss des Basic-Modells sind nicht mit den Modellen 701-705 kompatibel.

1. Sind alle Tastaturen und Schlésser austauschféhig/miteinander kombinierbar?
A. Die Tastaturen und Schlésser des 700 Basic-Modells sind nicht mit anderen Schldéssern und Tastaturen
der 700er-Serie kompatibel.

2. Verfligt die Tastatur des 700 Basic-Modells tber ein Display?
A. Nein.

3. Welche Ausfilihrungen des 700 Basic werden angeboten?
A. Schwenkriegel, Sperrriegel vorkonfiguriert.

4. Welche Riegelkonfigurationsoptionen sind fiir den Sperrriegel des 700 Basic-Modells verfligbar?
A. Wir bieten:
— Sperrriegel 1,37"
- 1,37" x M4, mit Bohrung oder Gewinde
- 1,37" x 10-32, mit Bohrung oder Gewinde
-2,37"
-1,85"

5. Gibt es die Tastatur in flacher Ausfuhrung?
A. Nein.

6. Wo wird das Kabel der Tastatur am Schlossgehduse eingesteckt?
A. ENT-Anschluss (Eingang).

7. Lassen sich die Tastenténe stummschalten?
A. Nein.

8. Wie finde ich heraus, welches Tastaturmodell ich habe?
A. Drlcken Sie zur Identifizierung eines LA GARD Basic-Modells die Rautetaste. Bei Tastaturen des
700 Basic-Modells schaltet die Hintergrundbeleuchtung ein, das Schloss reagiert aber nicht auf diesen
Befehl. Hinweis: Bei den Modellen 701-705 leuchtet die LED grin.

9. Wird eine Gewdihrleistung angeboten?
A. 2 Jahre ab Herstellungsdatum.

10. Welche Farboptionen gibt es fiur das 700 Basic?
A. Schwarz und Chrome matt/schwarz.



11. Welche Art von Batterie ist fir die Tastatur des 700 Basic-Modells geeignet?
A. Die Batteriebox und das Fach sind fur zwei 9-V-Alkaline-Batterien ausgelegt. Das System kann auch mit
einer 9-V-Batterie betrieben werden. Dies wird jedoch nicht empfohlen.

12. Gibt das 700 Basic eine Warnung bei schwacher Batterie aus?

Es wird empfohlen, die Batterien einmal jahrlich auszuwechseln. Verwenden Sie nur hochwertige 9-Volt-
Alkaline-Batterien.

Warnung bei schwacher Batterie: Bei der Offnung des Schlosses wiederholt die Tastatur das Signal

funf Mal. o« x5 Diese Warnung weist darauf hin, dass die Batterie schwach ist und ausgetauscht
werden sollte.

Warnung bei kritisch niedrigem Batteriestand: Die Tastatur wiederholt beim Driicken jeder beliebigen Taste
das Signal zehn Mal. ) ¢ x 10 Diese Warnung weist darauf hin, dass das Schloss nicht sicher betrieben
werden kann. Die Batterien missen ersetzt werden, um das Schloss weiter benutzen zu kénnen.

13. Wie aktiviere ich das Schloss?
A. Eine Aktivierung ist beim 700 Basic nicht erforderlich.

14. Uber welche Zertifizierungen verfiigt die 700er-Serie?
A. UL
B. Vds
C. UKCA
D. EN 1300
E. A2P
F.CE
G. SBSC

15. Sind die Tastatur und das Schloss des 700 Basic-Modells mit dlteren LA GARD-Produkten kompatibel?
A. Die Tastaturen und Schldsser der 700er-Serie sind nicht mit dlteren LA GARD-Produkten kompatibel.

16. Sind die Tastatur und das Schloss des 700 Basic-Modells mit anderen Modellen der 700er-Serie kompatibel?
A. Die Tastatur und das Schloss des 700 Basic-Modells sind nicht mit anderen Modellen der 700er-Serie
kompatibel.

17. Funktioniert das aktuelle Zubehér mit der neuen 700er-Serie?
A. Nein. Es gibt folgendes neues Zubehor fir die 700er-Serie.
Teilenummer:
704065: 700er-Serie Resetbox.
704055: 700er-Serie Batteriebox.
707040: USB-Dongle.
203325: USB-auf-Micro-USB-Kabel.
701107: Multi-Adapter Spannungsversorgung.
701131: Kabel Spannungsversorgung, 4,87 Meter (16 FuB).



18. Kann ich mein Schloss Uber die LA GARD-Software programmieren?
A. Nein.

19. Das Passwort fiir die LA GARD-Software funktioniert nicht. Ldsst sich das Passwort zuriicksetzen?
A. Nein, aber das Standardpasswort lautet LAGARD.

20. Muss die Software auf jedem Computer lizenziert werden?
A. Ja, auch fir die kostenlose Software ist eine Benutzerregistrierung erforderlich.

21. Wie viele Schlésser sind in einer Lizenz enthalten?

Teilenummer Max. Anzahl verwalteter Schlésser
700068 Max. 100 pro Datenbank

700069 Max. 250 pro Datenbank

700074 Max. 1.000 pro Datenbank

22. Warum verbindet sich mein Schloss nicht mit der Software?
A. Nutzen Sie zur Verbindung mit der Software immer einen USB-Dongle.

23. Warum wird mein USB-Dongle nicht im Gerdtemanager angezeigt?
A. Sie mUssen die USB-Treiber installieren.
Die Treiber kbdnnen Sie hier herunterladen: https://ftdichip.com/drivers/d2xx-drivers.

24. Wie erhalte ich eine Kopie der neuesten Software oder Firmware der 700er-Serie?
A. Die neuen Software- und Firmwareversionen werden wie beim Kauf der Software Gber die Website
angefordert: https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/
la-gard-700-series-software-download.

25. Wie aktualisiere ich meine Software?
A. Installieren Sie die neue Software der 700er-Serie als Administrator. Die vorhandene Version muss nicht
entfernt werden. Ihre Daten bleiben gespeichert.

26. Ich habe versucht, die Firmware meines Schlosses/meiner Tastatur zu aktualisieren. Die Tastatur reagiert
aber nicht. Angezeigt wird ,,Lock 1 boot" oder ,,F/W update”. Was bedeutet das und wie kann ich das
Problem beheben?

A. Das passiert, wenn die Firmware-Aktualisierung unterbrochen wird und die Tastatur den
Aktualisierungsmodus nicht verlassen kann. Sie kénnen das Problem wie folgt beheben:
e Wenn das Schloss nicht an einen Multiplexer angeschlossen ist:
SchlieBen Sie die Tastatur an den PC an und senden Sie die Firmware erneut Uber die Software.
e Wenn das Schloss an einen Multiplexer angeschlossen ist:
Trennen Sie das Schloss und die Tastatur vom Multiplexer und schlieBen Sie das Schloss an die Tastatur
an. SchlieBen Sie die Tastatur an den PC an und senden Sie die Firmware erneut Uber die Software.


https://ftdichip.com/drivers/d2xx-drivers
https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-series-softwa
https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-series-softwa

700er-Serie
Modelle 701-705 — Technische Daten

Modell 701 Modell 702/702D Modell 703/703B Modell 704/704B Modell 705
Schloss mit Multi-User-Schloss  Multi-User-Zugriff, Multi-User-Zugriff, Multi-User-Zugriff,
2 Benutzern mit Standard- 2-Schloss-System,  5-Schloss-System,  5-Schloss-System,
tastatur Display Display Display
Tastatur mit OLED-Display Nein Nein/Ja (702D) Ja Ja Ja

Kompatible Schlosstypen

Schwenk-/Sperr-/
gefederter Riegel/
redundantes Schloss

Schwenk-/Sperr-/
gefederter Riegel/
redundantes Schloss

Schwenk-/Sperr-/
gefederter Riegel/
redundantes Schloss

Schwenk-/Sperr-/
gefederter Riegel/
redundantes Schloss

Schwenk-/Sperr-/
gefederter Riegel/
redundantes Schloss

Anz. Benutzer

1Master/ 1 Manager/

1Master/ 1 Manager/

1Master/ 1 Manager/

1 Master/ 2 Manager/

1Master/ 2 Manager/

1Benutzer 28 Benutzer 28 Benutzer 47 Benutzer 97 Benutzer
Anz. Schlésser 1 1 2 5 5
Vieraugen-Prinzip Nein Ja Ja Ja Ja
N e Nein Ja Ja Ja Ja
Rucksetzfunktion Ja Ja Ja Ja Ja
Zeitverzégerung Nein 0-99 Min. 0-99 Min. 0-99 Min. 0-99 Min.
Bestdtigungsfenster Nein 1-60 Min. 1-60 Min. 1-60 Min. 1-60 Min.
Zetoerzbgerang (TDO) Nein Ja Ja Ja Ja
;Eﬁﬁrzis';chI;:I:\ﬁnger Nein Nein Nein Nein Ja
Programmierbar liber Tastatur Ja Ja Ja Ja Ja
Programmierbar liber PC Nein Ja Ja Ja Ja
Priifereignisse Nein 500 500 2.000 6.000
Anzeigbares Priifprotokoll Nein Nein/Ja (702D) Ja Ja Ja
Efur f‘";;etrcl,igﬁ“res Nein Ja Ja Ja Ja
Bedrohungsalarm Nein Ja Ja Ja Ja
Codeldnge 11(2id + 6-9) 11(2id + 6-9) 11 2id + 6-9) 11(2id + 6-9) 11(2id + 6-9)
L?::::;:ur::;beleuchtung Nein Ja Ja Ja Ja
Riegelschaltkontakt-Option** Nein Ja Ja Ja Ja
Manipulationssperre Ja Ja Ja Ja Ja
Batterieversorgung 2x9V 2x9V 2x9V 2x9V 2x9V
Option in flacher Ausfiihrung Nein Ja Ja Ja Nein
Zusatzliches Netzteil* Ja Ja Ja Ja Ja
VdS 2396 - Klasse 2 Ja Ja Ja Ja Nein
UL 2058 — UL Typ 1 Ja Ja Ja Ja Ja
EN1300 - Stufe B Ja Ja Ja Ja Nein
SBSC - 3880:2015 Ja Ja Ja Ja Nein
CNPP a2p - Stufe B/E Ja Ja Ja Ja Nein
Zeitplan fiir Zeitsperren Nein Nein Nein Ja Ja
Doppelberechtigungsnachweis Nein Nein Nein/Ja (703B) Nein/Ja (704B) Ja

2 Jahre ab 2 Jahre ab 2 Jahre ab 2 Jahre ab 2 Jahre ab

Gewdhrleistung

Herstellungsdatum

Herstellungsdatum

Herstellungsdatum

Herstellungsdatum

Herstellungsdatum

Aktualisierbare Firmware

Ja

Ja

Ja

Ja

Ja

** Siehe FAQ Nr. 33



LA GARD 700er-Serie
Haufig gestellte Fragen (FAQ)

Modelle 701-705

Hinweis: Die Modelle 701-705 sind nicht mit den Tastaturen und Schléssern des 700 Basic-Modells kompatibel.

1. Sind alle Tastaturen und Schlésser austauschfdhig/miteinander kombinierbar?

A. Ja, im Auslieferungszustand kénnen alle Schlésser und Tastaturen miteinander kombiniert werden.
Wurden Schlésser bereits mit einem System gekoppelt, lassen sie sich mithilfe der Resetbox der LA GARD
700er-Serie (704065) zurlicksetzen. Alternativ kann ein Schloss von der alten Tastatur deinstalliert (#23)
und auf der neuen Tastatur installiert werden. Bei einem Wechsel zu einer Tastatur des gleichen Modells
muss das Schloss nicht zurlickgesetzt oder deinstalliert (#23) werden.

2. Verfugen alle Tastaturen lber ein Display?
A. Die Modelle 702D-705 verflgen Uber ein Display.

3. Welche Ausfiihrungen werden angeboten?
A. Gefederter Riegel, Schwenkriegel, Sperrriegel, redundantes Schloss.
B. Schlésser kdnnen mit einem Riegelschaltkontakt ausgestattet werden.

4. Welche Tastaturen sind mit Schléssern mit einer Spindel kompatibel?
A. Alle Tastaturen kdnnen mit Schléssern mit Sperrriegel, gefedertem Riegel oder Schwenkriegel verwendet
werden. Die Spindeln werden mit dem Schloss und nicht mit den Tastaturen geliefert.

5. Welche Tastaturen sind in flacher Ausfiihrung verfiigbar? Was wird noch fir eine ordnungsgemdBe Funktion
einer Tastatur in flacher Ausfiihrung benétigt?

A. 702, 703, 704.

B. Fur jede Tastatur in flacher Ausfihrung ist eine Batteriebox (704055) oder eine Alarm/Batteriebox
(704045) erforderlich. Hinweis: An allen Tastaturen in flacher Ausfihrung befindet sich eine Buchse fir
den Anschluss einer Notstrombatterie bei einem Ausfall der internen Stromversorgung.

C. Fur den Fall, dass die Batterien in der Batteriebox leer sind, steht im Standardbatteriebereich ein
Batteriestecker fir den Notstrombedarf zur Verfigung.

6. Wo wird das Kabel der Tastatur am Schlossgehduse eingesteckt?
A. ENT-Anschluss (Eingang).

7. Lassen sich die Tastenténe stummschalten?
A. Ja.
Modell ohne Display:
1. Geben Sie mit der Tastatur Folgendes ein: #41 + ID und Code des berechtigten Benutzers + Aus (0) oder
Ein (1) + Eingabetaste. @)
2. Die Tastatur reagiert zum Abschluss mit drei Signalténen und einer blinkenden grinen LED.



Modell mit Display:

1. Navigieren Sie durch das Hauptment und wdhlen Sie ,System*” aus.

2. Wéhlen Sie ,Buzzer"” im Untermeni aus.

3. Wahlen Sie ,Yes" oder ,No" aus, um den Summermodus zu aktivieren bzw. zu deaktivieren.

4. In der Anzeige wird ,Success Mode updated” angezeigt und die Tastatur reagiert zum Abschluss mit zwei
Signalténen und einer blinkenden grinen LED.

8. Wie finde ich heraus, welches Tastaturmodell ich habe?
A. Auf jeder Tastatur ist ein Aufkleber zu finden:
e Standardausfihrung — der Aufkleber befindet sich im Batteriefach auf der rechten Seitenwand.
¢ Flache Ausfuhrung — der Aufkleber befindet sich auf der Innenseite der Schwingtir an der unteren
Platte, die zum Stecker fuhrt.

B. Auf dem Modell mit Display k&nnen Sie die Information Uber die Eingabeaufforderungen im OLED-Menu
unter ,System” - ,Sys Info" - ,Entry” finden und bis zur Modellnummer scrollen.

C. Verwenden Sie zur Unterscheidung zwischen dem Modell 701 und dem Modell 702 ohne Display den
Befehl ,Hintergrundbeleuchtung”. Geben Sie mit der Tastatur Folgendes ein: #40 + ID und Code des
berechtigten Benutzers + Aus (0) oder Ein (1) + Eingabetaste. Q Wenn die Tasten aufleuchten, handelt
es sich um das Modell 702. Wenn die Tastatur nach der Eingabe von #40 Signalténe ausgibt und die
LED rot leuchtet, handelt es sich um das Modell 701.

9. Was ist der Unterschied zwischen den Befehlen #23 und #25 (701, 702)?

A. Deinstallieren (#23) ,entkoppelt” die Tastatur vom Schloss. Im Schloss bleiben alle Einstellungen und
Codes gespeichert. Eine DEINSTALLATION wird in der Regel nur durchgefuhrt, wenn eine Tastatur
absichtlich ausgetauscht wird. Der Deinstallationsbefehl muss nur dann verwendet werden, wenn das
Modell gewechselt wird (z. B. von einem 702 auf ein 703). Wird die Tastatur durch das gleiche Modell
ersetzt (,Hot Swap"), kdnnen Sie den Befehl Neu installieren (#32) verwenden. Bei Gerdten mit Display
erkennt das System den ,Hot Swap" und fuhrt den Benutzer durch den Neuinstallationsprozess.

(#25) ist der Master Reset, der das Schloss auf die Werkseinstellungen zuriicksetzt. Es werden keine
Programmierdaten gespeichert. Prifdaten bleiben im Schloss gespeichert. Ein solcher Reset wird
durchgefihrt, wenn ein anderes Tastaturmodell als Ersatz gewdahlt wird oder wenn das Schloss einfach
auBer Betrieb genommen und auf die Werkseinstellungen zurtickgesetzt werden soll.

10. Muss beim 701 der Manager ,,01" und der Standardbenutzer ,,02" sein?
A.,01" oder ,02" kdnnen beim 701 jeweils fur den Manager oder Benutzer genutzt werden. Hinweis: Beim 701
lassen sich nur Benutzer 01 und 02 programmieren.

11. Was ist ein Primdrschloss?
A. Bei der Verwendung mehrerer Schlésser in einem Mehrschlosssystem ist das Primdrschloss das Schloss
Nummer 1 (#1).

12. Warum muss die Tastatur wissen, welches Schloss das Primdrschloss ist?
A. Die Tastatur muss wissen, an welches Schloss eine Alarmbox angeschlossen ist.



13. Wird eine Gewdhrleistung angeboten?
A. 2 Jahre ab Herstellungsdatum.

14. Welche Farboptionen gibt es?
A. Schwarz und Chrom matt.

15. Welche Art von Batterie ist fiir die Tastatur geeignet?
A. Die Batteriebox und das Fach sind fur zwei 9-V-Alkaline-Batterien ausgelegt.
B. Das System kann auch mit einer 9-V-Batterie betrieben werden. Dies wird jedoch nicht empfohlen.

16. Wie viele Offnungen lassen sich mit zwei 9-V-Batterien durchfiihren?
A. Wir schatzen, dass zwei neue 9-Volt-Markenbatterien (z. B. Duracell oder Energizer) unter optimalen
Bedingungen bis zu zwei Jahre halten.
B. Die LA GARD 700er-Serie gibt ein Signal bei schwacher Batterie bzw. bei einem kritisch niedrigen
Batteriestand aus. Die Lebensdauer der Batterien kann aufgrund der Umgebungsbedingungen,
der Haufigkeit der Nutzung und der Qualitdt der Batterien variieren. Wir empfehlen, einen Zeitplan far
den Batteriewechsel festzulegen.

17. Gibt das Gerdt eine Warnung bei schwacher Batterie aus?
A. Ja, das Schloss warnt den Benutzer bei schwacher Batterie.

Ereignis Summer LED Meldungen in der Anzeige
(nur Display)

Niedriger 1 kurzer niedriger 1langes Blinksignal  Low Battery

Batteriestand Signalton

Kritisch niedriger 3 lange niedrige 3 lange Critical Low Battery

Batteriestand Signaltdne Blinksignale

18. Wie aktiviere ich das Schloss?
A. Drlcken Sie bei Modellen mit oder ohne Display eine beliebige Taste.

19. Uber welche Zertifizierungen verfiigt die 700er-Serie?
A. UL - ja.
B. Vds — ja (auBer 705).
C. CNPP — ja (auBer 705).
D. UKCAE - ja (auBer 705).
E. EN1300 — ja (auBer 705).
F. A2P — ja (auBer 705).
G. CE — ja (auBer 705).

20. Ist die 700er-Serie ruckwdartskompatibel zu den verschiedenen Ausfihrungen élterer LA GARD-Produkte?
A. Die 700er-Serie ist nicht rickwdrtskompatibel zu &lteren LA GARD-Produkten.



21. Funktioniert das aktuelle Zubehér mit der neuen 700er-Serie?
A. Spannungsversorgung — (701107) ja.
Es gibt neues Zubehor fur die 700er-Serie.

Produkt Teilenummer
Batteriebox 704055
Batch B90165
Multiplexer 704033
Resetbox 704065
Alarmbox 704045

Kabel zur Verbindung des Multiplexers  43109-1
mit dem Schloss, 46 cm (18 Zoll)

Produkt Teilenummer

Kabel zur Verbindung des Multiplexers ~ 43109-2
mit dem Schloss, 91.cm (36 Zoll)

Kabel zur Verbindung des Multiplexers 702130
mit dem Schloss, 183 cm (72 Zoll)

Kabel zur Verbindung des Multiplexers 702131
mit dem Schloss, 305 cm (120 Zoll)

USB-Dongle 707040

USB-auf-Micro-USB-Kabel 203325

Multi-Adapter Spannungsversorgung 701107

22. Kann der BLE-Batch mit mehreren Schléssern und mehreren Benutzern gekoppelt werden?
A. Wir empfehlen zwar eine 1:1-Konfiguration, der Batch kann aber sowohl fir mehrere Schlésser als auch fur
mehrere Benutzer verwendet werden, wenn der Benutzer den Zugang auf diese Weise konfiguriert.

23. Was bedeuten die Blinksignale auf dem BLE-Batch?

A. Die LED blinkt griin bei Tastendruck.
B. Wenn die Verbindung erfolgreich hergestellt und die ID erkannt wurde, blinkt die LED ein zweites Mal gran.
e im Abstand von ~1 Sekunde.
C. Wenn die Verbindung fehlgeschlagen ist oder die ID nicht erkannt wurde, blinkt die LED rot.
e im Abstand von ~5 Sekunden.
D. Tastendriicke werden beim Verbindungsversuch und der ID-Ubermittlung ignoriert.

BLE-Batch — Batteriestand:
A. Wenn die Batteriespannung zwischen 2,3 und 2,1 Volt liegt, ist das erste LED-Blinksignal gelb/orange statt
grun (sowohl die grine als auch die rote LED leuchten), was auf einen niedrigen Batteriestand hinweist.
Wenn die Batteriespannung unter 2,1 Volt liegt, blinkt die rote LED bei Tastendruck. Das Blinksignal weist
darauf hin, dass die Batterie leer ist. In diesem Zustand wird kein Versuch unternommen, eine Verbindung
zur Eingabeeinheit herzustellen.

Bei Tastendruck ID-Ubermittlung Ubersetzung

Grin Grun (~1 Sekunde nach 1. LED) Identifizierung erfolgreich

Grun Rot (~5 Sekunden nach 1. LED) Identifizierung fehlgeschlagen

Gelb/Orange Grun (~1 Sekunde nach 1. LED) Identifizierung erfolgreich — schwache Batterie

Gelb/Orange

Rot (~5 Sekunden nach 1. LED)

Identifizierung fehlgeschlagen — schwache Batterie

Rote LED

Keine

Batterie leer



24. Kann die Batterie im BLE-Batch ausgetauscht werden?
A. Ja, der BLE-Batch lésst sich 6ffnen, um die Batterie auszutauschen.

25. Welche Art von Batterie ist fur den BLE-Batch geeignet?
A. CR2032.

26. Kann ich mein Schloss Uber die LA GARD-Software programmieren?
A. Ja, die Modelle 702-705 kénnen Uber die Software eingerichtet werden.
B. Die Zeitpldane fur die Modelle 704 und 705 mussen Uber die Software programmiert werden.

27. Wie erhalte ich Firmware-Aktualisierungen?
A. Die Firmware kann ohne zusdtzliche Kosten Uber die kostenlose Version unserer Softwareanwendung

mit dem USB-Kabel (203325) und dem USB-Dongle (707040) heruntergeladen werden.

28. Das Passwort fiir die LA GARD-Software funktioniert nicht. Lasst sich das Passwort zuriicksetzen?
A. Nein, aber das Standardpasswort lautet LAGARD.

29. Muss die Software auf jedem Computer lizenziert werden?
A. Ja.

30. Wie viele Schlosser sind in einer Lizenz enthalten?

Teilenummer Max. Anzahl verwalteter Schlosser Kommentar

700068 100 Max. pro Datenbank
700069 250 Max. pro Datenbank
700074 1.000 Max. pro Datenbank

31. Warum verbindet sich mein Schloss nicht mit der Software?
A. Nutzen Sie zur Verbindung mit der Software immer einen USB-Dongle.

32. Warum wird mein USB-Dongle nicht im Geréitemanager angezeigt?
A. Sie mUssen die USB-Treiber installieren.
Die Treiber kdnnen Sie hier herunterladen: https://ftdichip.com/drivers/d2xx-drivers.

33. Was macht der Riegelschaltkontakt?
Es gibt drei Optionen am Schlossgehduse:
A. Kein Riegelschaltkontakt (siehe ,kein Riegelschaltkontakt” in der Preisliste).
B. Interner Riegelschaltkontakt: In diesem Fall sind Offnungs- und SchlieBstatus des Riegels im Priifprotokoll
aufgefthrt (siehe zweite Option flr die Schlossbestellung, bei der ,mit Riegelschaltkontakt” angegeben wird).
C. Externer Riegelschaltkontakt: Dabei handelt es sich um einen Kabelbaum, der fur die Status ,normal
offen”/,normal geschlossen” eine externe Verkabelung in ein Alarmsystem ermaoglicht. Bei dieser Option
wird keine Prifung durchgefihrt (siehe unter konfigurierbare Optionen: Riegelschaltkontakt mit
Kabelbaum).


https://ftdichip.com/drivers/d2xx-drivers

34. Wie erhalte ich eine Kopie der neuesten Software oder Firmware der 700er-Serie?
A. Die neuen Software- und Firmwareversionen werden wie beim Kauf der Software Uber die Website
angefordert: https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/
la-gard-700-series-software-download.

35. Wie aktualisiere ich meine Software?
A. Installieren Sie die neue Software als Administrator. Die vorhandene Version muss nicht entfernt werden.
Ilhre Daten bleiben gespeichert.

36. Wie aktualisiere ich die Firmware meines Schlosses und meiner Tastatur?
A. Wd&hlen Sie im Hauptmenu der LA GARD Software die Option ,Settings” aus.
B. Tragen Sie im Untermeni ,Firmware Update” die folgenden Informationen ein:

e Port: Wahlen Sie den erforderlichen COM-Port im Drop-down-Menu aus.

o Firmware-Datei: Verwenden Sie die Schaltfldche ,Datei auswdhlen”, um auf dem Computer die Datei
mit der Firmware-Aktualisierung zu suchen. Wenn Sie die Datei gefunden haben, wéhlen Sie ,Offnen”
im Browserfenster aus.

e Wenn Schloss-Firmware ausgewdhlt wurde, wird eine weitere Option angezeigt, damit ausgewdhlt
werden kann, welches Schloss aktualisiert werden soll. (HINWEIS: Es kann jeweils nur eine Schloss-
Firmware aktualisiert werden.)

C. Stecken Sie das USB-Kabel in den USB-Anschluss am Computer und das andere Ende in den Mini-USB-

Anschluss an der Tastatur.

D. Gehen Sie bei einer Tastatur mit Display wie folgt vor:

¢ Navigieren Sie mit den Pfeiltasten auf der Tastatur durch das Hauptmeni und wdahlen Sie ,System* aus,
indem Sie die Eingabetaste driicken. @

¢ Navigieren Sie im Menu ,System" durch die Optionen und wdhlen Sie ,FW Update” aus, indem Sie die
Eingabetaste dricken. Q In der Anzeige wird ,Start FW Update” angezeigt.

E. Gehen Sie bei einer Tastatur ohne Display wie folgt vor:
e Geben Sie #99 + Master-Code ein.
Dadurch wird in der Tastatur der Modus ,FW-Aktualisierung” aktiviert.
F. Wahlen Sie im Software-Client die Schaltfldche ,Upload” aus. In der Anzeige wird ein Fortschrittsbalken
angezeigt. Die Tastatur reagiert zum Abschluss mit drei Signalténen und einer blinkenden griinen LED.

Hinweis: Bei der Aktualisierung der Firmware bleiben alle Benutzer und Codes im Schloss erhalten.
Es gehen keine Daten verloren.

37. Ich habe versucht, die Firmware meines Schlosses/meiner Tastatur zu aktualisieren. Die Tastatur reagiert
aber nicht. Angezeigt wird ,,Lock 1 boot" oder ,,F/W update”. Was bedeutet das und wie kann ich das
Problem beheben?

A. Das passiert, wenn die Firmware-Aktualisierung unterbrochen wird und die Tastatur den
Aktualisierungsmodus nicht verlassen kann. Sie kénnen das Problem wie folgt beheben:
e Wenn das Schloss nicht an einen Multiplexer angeschlossen ist:
SchlieBen Sie die Tastatur an den PC an und senden Sie die Firmware erneut Uber die Software.
e Wenn das Schloss an einen Multiplexer angeschlossen ist:
Trennen Sie das Schloss und die Tastatur vom Multiplexer und schlieBen Sie das Schloss an die Tastatur
an. SchlieBen Sie die Tastatur an den PC an und senden Sie die Firmware erneut Uber die Software.


https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-series-software-download
https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-series-software-download

Anhang A

LA GARD-Modelle mit Display

Hochsicherheitsschloss fiir Tresore und Tresorrdume

Allgemeine Bedienungsanleitung

Verfligbare Benutzer und Standardcodes

Die Schlésser werden hdufig so eingerichtet, dass die ID ,01" einem
Manager mit der Standardberechtigung zum Offnen und Priifen des
Schlosses zugewiesen wird. Es ist Ublich, diesem Benutzer den
Standardcode 123456 zuzuweisen.

ID Profil (ID) Standardcode

00 Master (0-0)-1-2-3-4-5-6-7-8

01 Manager (0-1)-Kann durch Master-Benutzer
hinzugefligt werden.

02-29 Benutzer Kann durch Master-Benutzer oder Manager

hinzugeflgt werden.

Warnung: Der Master-Benutzer muss den Code bei der erstmaligen
Verwendung dndern. Der Master-Benutzer kann Manager- und
Standardbenutzer dazu auffordern, ihre Codes bei der ersten
Verwendung zu éndern. Dazu muss er die Regel ,Code-Anderung
erzwingen” in den Systemeinstellungen aktivieren.

Benutzerhierarchie

Master (0 0)

\ 4
Manager (0 1)

\/
Benutzer (02-29) <1

Benutzerprofile
Profil Berechtigung
Master ¢ Administrative Kontrolle des Schlosses und anderer
Benutzer.
e Kann nicht direkt 6ffnen.
Manager e Schloss &ffnen, eigenen Code dndern.

e Benutzer verwalten (hinzuflgen, l6schen, deaktivieren,
aktivieren, zurlcksetzen).

» Zeitverzdégerungswerte festlegen.

e PC Link fur Prifung aktivieren.

e Datum und Uhrzeit einstellen.

¢ Hintergrundbeleuchtung und Tastatursignale ein- und
ausschalten.

¢ Zeitverzdégerung umgehen (wenn im Profil festgelegt).

Benutzerprofile

Benutzer e Schloss 6ffnen, eigenen Code &ndern.
e Zeitverzégerung umgehen (wenn im Profil festgelegt).
e PC Link fur Prifung aktivieren (wenn im Profil

festgelegt).

Codeldange

Der Master-Code setzt sich immer wie folgt zusammen:

ID 00 + achtstelliger Code. Andere Benutzercodes setzen sich aus
der zweistelligen ID + einem standardmaBig sechsstelligen

Code zusammen. Die Codeldnge l&sst sich jedoch dndern und kann
6-9 Ziffern betragen.

Tastatur

Taste

@O

Verwendung

Pfeiltaste aufwdrts oder Pfeiltaste abwdrts: Durch das
MenU blattern.

® #: Im MenU einen Schritt zurickgehen oder Codeeingabe
abbrechen.

o Eingabetaste: Menlpunkt auswdhlen oder Eingabe
bestatigen.

Befehle

Nicht 6ffnende Funktionen stehen den Benutzern je nach Profil zur
Verfligung. In dieser Anleitung werden die nachstehenden Befehle
erldutert:

Kategorie Funktion

Codes e Code andern.

Benutzerver- e Benutzer hinzufligen.

waltung ¢ Benutzer deaktivieren/erneut aktivieren.

e Benutzerberechtigungen dndern.
¢ Benutzer l&schen.
e Benutzercode zuriicksetzen.

Zeitverzégerung e Zeitverzégerungswerte éndern.

e Z&hlung der Zeitverzdgerung beenden.

Allgemeine
Bedienung

¢ Hintergrundbeleuchtung deaktivieren oder
aktivieren.

¢ Tastatursignale aus- oder einschalten.

e Uhrzeit und Datum festlegen.

Die erweiterten Befehle sind in einem separaten Dokument
aufgefihrt: Advanced User Instructions ist zum Download auf
unserer Website verfugbar.



Kategorie Funktion
Codes e Codeldnge &ndern.
e Vieraugen-Prinzip aktivieren oder
deaktivieren.

o Allgemeine e Funktion ,Bedrohung"” aktivieren oder
% Bedienung deaktivieren.
E’ e Einstellungen des Alarmeingangs festlegen.
£ Audit * PC Link aktivieren, Prifereigniscodes
9 einsehen.
)
3 Manager- ¢ Manager hinzufligen.
"” Verwaltung * Manager deaktivieren/erneut aktivieren.

e Manager-Berechtigungen &ndern.
e Manager l6schen.
e Manager-Code zuriicksetzen.

Zeitverzége- ¢ Umgehung der Zeitverzdégerung aktivieren.
rung o Z&hlmodus der Zeitverzégerung einstellen.

Befehlsmenii

Befehlsmeni aufrufen:
e Dricken Sie die Pfeiltaste aufwdrts, Pfeiltaste abwdrts oder die
Eingabetaste.

Q0. -

e Geben Sie eine gultige ID und, wenn Sie dazu aufgefordert
werden, den Code ein.

Navigation im Befehlsmeni

Verwenden Sie zum Bldattern durch die Men(s die Pfeiltaste
aufwdrts und die Pfeiltaste abwaérts. Ausgewdhlte Menlpunkte
oder Optionen werden weiB hervorgehoben. Driicken Sie die
Eingabetaste, um eine Auswahl zu best&tigen oder ein Untermeni
aufzurufen. Driicken Sie die Rautetaste, um zum vorherigen Ment
zurlickzukehren oder das Ment zu verlassen.

Visuelle und akustische Signale

Der Schlossstatus wird durch Meldungen auf dem Display,
LED-Blinksignale und Signaltdne angezeigt.

Signal Symbol

Grlines Blinksignal + kurzer hoher Signalton OrD)

Bedeutung: Taste korrekt gedrickt R

Rotes Blinksignal + kurzer niedriger Signalton Ow

Bedeutung: Tasteneingabe ungliltig -

3 grne Blinksignale + kurze hohe Signalténe BISIGIDLDLD)
Bedeutung: Befehl oder Code akzeptiert

3 rote Blinksignale + kurze niedrige Signalténe (7)) () o

Bedeutung: Code oder Befehl ungdiltig

Schloss 6ffnen Manager/Benutzer

Je nach Bauart des Tresors oder Tresorraums muissen
moglicherweise zuerst andere Schldsser wie Schliusselschlésser
gedffnet werden. Alle Handlungen, die zum Offnen der Tar und des
Schlosses erforderlich sind, sollten in umgekehrter Reihenfolge
ausgeflihrt werden, um die Tur und das Schloss zu schlieBen und zu
sichern.

e Geben Sie eine gultige ID und, wenn Sie dazu aufgefordert
werden, den Code ein.

e Drehen Sie innerhalb von 3 Sekunden die Tastatur und/oder den
Tresorgriff.

Tresorschloss 6ffnen bei aktiver Zeitverzégerung

Fiihren Sie die folgenden Schritte aus, um an einer Tastatur mit
Display ein Tresorschloss wéhrend einer Zeitverzégerung zu 6ffnen:

1. Geben Sie mit der Tastatur die Benutzer-ID und den Benutzercode
ein.

2. Wenn dies ein Mehrschlosssystem ist, dann wdhlen Sie die Nummer
des entsprechenden Schlosses auf der Tastatur aus. Andernfalls
fahren Sie mit dem néchsten Schritt fort.

3. In der Anzeige wird ,Lock # Start Delay” mit einem Zdhler-Feedback
angezeigt. Die Art des Feedbacks hé&ngt von der Einstellung fir das
Zahler-Feedback ab (entweder wird die Zeit abwdrts oder
aufwdrts gezdhlt oder es wird nur die verbleibende Zeit angezeigt).
Um den Status der Zeitverzdgerung zu prifen, muss eine Taste
gedrickt werden. Wenn eine Taste auf einer Tastatur mit Display
gedrickt wird, wird das ,dringendste” Schloss angezeigt.

a) Dringendstes Schloss: In einem Einzelschlosssystem gilt der
Status der Zeitverzdgerung flr ein einziges Schloss. In einem
Mehrschlosssystem wird i) fiir das Schloss mit der geringsten
verbleibenden Zeitspanne im Bestdtigungsfenster der Status
angegeben oder ii) wenn kein Schloss im Bestdtigungsfenster ist,
wird das Schloss mit der geringsten verbleibenden Zeitspanne im
Verzdgerungsfenster angezeigt.

4. Wenn die Dauer der Zeitverzdgerung abgelaufen ist, wird ,Lock #
status Confirm" angezeigt.

5. Wenn ein Schloss im Bestatigungsfenster ist, kann es gedffnet
werden. Driicken Sie eine Taste, um den Status der Zeitverzégerung
zu verlassen.

(e}

. Geben Sie die Benutzer-ID und den Benutzercode ein.

~

Wdéhlen Sie ,Open Lock” im Untermend aus. a) Wenn dies ein
Mehrschlosssystem ist, dann wdéhlen Sie die Nummer des
entsprechenden Schlosses auf der Tastatur aus. Wenn fir das
ausgewdhlte Schloss die Zeitverzégerung aktiviert wurde und

i) es noch nicht in der Zeitverzégerung ist, wird die Zeitverzégerung
fUr das Schloss gestartet. ii) Wenn es bereits in der Zeitverzégerung
und im Bestdatigungsfenster ist, wird das Schloss gedffnet.

8. Das Schloss wird gedffnet und in der Anzeige wird ,Lock Open”
angezeigt. Nach einigen Sekunden wird das Schloss geschlossen.

Umgehung der Zeitverzégerung

Wenn diese Funktion aktiviert und einem Benutzer die Berechtigung
zur Umgehung einer Zeitverzégerung zugewiesen wurde, kann der
Code dieses Benutzers zum sofortigen Offnen des Schlosses
verwendet werden. Die Informationen zum Einrichten der
Berechtigungen zur Umgehung der Zeitverzégerung finden Sie im
Dokument Advanced User Instructions.

Schloss 6ffnen bei aktiviertem Vieraugen-Prinzip

e Geben Sie eine gultige ID und, wenn Sie dazu aufgefordert werden,
den Code ein.

e Geben Sie eine zweite glltige ID und, wenn Sie dazu aufgefordert
werden, den Code ein.

e Drehen Sie innerhalb von 3 Sekunden die Tastatur und/oder den
Tresorgriff.

Vieraugen-Prinzip fur Manager Manager
Wenn das Vieraugen-Prinzip flr Benutzer und Manager aktiviert
wurde, drlicken Sie zum Aufrufen der BefehlsmenUs die Pfeiltaste
aufwdrts, die Pfeiltaste abwdrts oder die Eingabetaste. Wahlen Sie
Go to Menu aus. Zuerst muss der Manager seine ID und seinen Code
eingeben, danach muissen eine zweite gultige ID und ein gultiger
Code eingegeben werden.



Hintergrundbeleuchtung Master/Manager Code dndern bei aktiviertem Vieraugen-Prinzip Ale
Die Tasten auf der Tastatur kdnnen als Orientierungshilfe in dunklen e Drucken Sie bei aktiviertem Vieraugen-Prinzip die Pfeiltaste
Bereichen beim ersten Tastendruck beleuchtet werden. aufwadrts, die Pfeiltaste abwérts oder die Eingabetaste, um das
Die Hintergrundbeleuchtung ist standardmaBig ausgeschaltet. Befehlsmenl aufzurufen. Navigieren Sie dann zu Change combo.

e Geben Sie eine gultige ID und, wenn Sie dazu aufgefordert
werden, den bisherigen Code ein.

e Geben Sie den neuen Code ein und wiederholen Sie ihn zur
Bestdatigung.

Befehlsmenii > System > Backlight > Wdhlen Sie ,on" oder ,off".

Tastatursignale Master/Manager

Die Tastatursignale lassen sich ausschalten, damit andere nicht

héren, wenn das Schloss bedient wird. Benutzer deaktiVIeren/erneUt Master/Manager

aktivieren

Befehlsmenii > System > Buzzer > Wahlen Sie ,on" oder ,off".

Ein Benutzercode kann vorlbergehend deaktiviert und spéter
wieder aktiviert werden.

. . Y :
Benutzer hInZUfugen aster/Manager Befehlsmenii > Users > Edit > Geben Sie die zu dndernde ID ein.

e Geben Sie eine gultige Benutzer-ID und einen gultigen o Wahlen Sie Status > ,disabled” oder ,enabled” aus.
Benutzercode ein: Command Menu > Users > Add.

e Geben Sie die neue Benutzer-ID ein.

e Wahlen Sie den Benutzertyp Manger oder Standard User. Benutzerberechtigungen dndern Master/Manager
¢ Geben Sie den Code ein und geben Sie ihn erneut ein, wenn Sie

aufgefordert werden, die Eingabe zu bestétigen Confirm. Es ist moglich, die Berechtigung eines Benutzers zu dndern und das
o Wdhlen Sie Add User. Offnen, die Prifung oder die Umgehung der Zeitverzégerung fir

jedes Schloss, das an die Tastatur angeschlossen ist, zu erlauben

Die Standardberechtigungen fir Manager und Standardbenutzer oder zu verbieten.
sind ,Access” (Zugriff) und ,Audit” (Prifung). Wahlen Sie zur Befehlsmenii > Users > Edit > Geben Sie die zu dndernde ID ein.
Anpassung der Berechtigungen fir diesen Benutzer eine der B ) -
verfligbaren Optionen aus: ,Open Priv* (Berechtigung zum Offnen), e Wahlen Sie Privileges aus.
,Audit Priv" (Berechtigung zum Prifen) oder ,TDO Pin Priv" Ein Untermeni wird angezeigt > Privileges >
(Berechtigung zur Umgehung der Zeitverzégerung mit TDO-PIN). > Open Priv
Beim Hinzufligen eines Managers ist auch die Berechtigung > Audit Priv
,TimeLock" (Zeitschloss bzw. Zeitsperre) verflgbar. > TDO Pin Priv

> Update User

e Wahlen Sie Open Priv, Audit Priv und TDO Pin Priv aus und passen
Sie die Einstellungen nach Bedarf an, wie unter Benutzer
hinzufliigen beschrieben.

Code dndern Alle

Offnungscodes sollten nach Méglichkeit bei gedffneter Tresor- oder
Tresorraumtlr gedéndert und getestet werden. e Wahlen Sie Update User aus.

Manager und Standardbenutzer sollten bei der erstmaligen
Verwendung ihren Code dndern und eine Testéffnung durchfihren.
Wenn die Standardeinstellungen des Systems nicht gedéindert Benutzer l6schen Master/Manager
wurden, ist dies nicht notwendig. Der Master-Benutzer kann die
Regel ,Code-Anderung erzwingen" aktivieren. Diese Regel zwingt

Befehlsmenii > Users > Delete > Geben Sie die zu [6schende ID ein.

Benutzer dazu, ihren Code bei der erstmaligen Verwendung zu » Wenn auf dem Display Confirm delete: xx angezeigt wird, driicken
&ndern. Sie die Eingabetaste.
Befehlsmenii > Change combo > Geben Sie den neuen Code
U Master/Manager
1. Geben Sie ID und Code eines berechtigten Benutzers ein. Benutzercode zurlicksetzen J
2. Wahlen Sie im Hauptmend in der Tastaturanzeige die Option Wenn ein Benutzer seinen Code vergessen hat, kann der Code
,Change combo” aus. zurlickgesetzt werden. Es ist nicht erforderlich, den Benutzer zu

l6schen und erneut hinzuzuftigen.
3. In der Anzeige wird ,New Combo" angezeigt. Geben Sie mit dem .
Ziffernblock einen neuen Code ein. Befehlsmenii > Users > Edit > Reset combo > Geben Sie die ID und
den Code eines berechtigten Benutzers ein.
Hinweis: Der neue Code muss sich vom alten Code unterscheiden.

Der Benutzer sollte einen Code verwenden, der nicht allzu leicht zu * Geben Sie den neuen Code ein und wiederholen Sie ihn zur
erraten ist. Bestdtigung.
4. In der Anzeige wird ,Confirm" angezeigt. Geben Sie denselben Nach dem erfolgreichen Zuriicksetzen des Codes sollte der
Code aus dem vorherigen Schritt zur Bestatigung erneut ein. Benutzer seinen Code dndern und eine Testé}ffnung bei gedffneter
Tur durchfiihren. Wenn die Funktion ,Code-Anderung erzwingen”
5. In der Anzeige wird ,Success® angezeigt. Die Tostatur reagiert aktiviert ist, muss der Benutzer seinen Code vor der erstmaligen
zum Abschluss mit drei Signalténen und einer blinkenden grinen Verwendung éndern.

LED und kehrt zum MenU ,Enter ID" zurlick. Der neue Code wird
festgelegt und ist wirksam, wenn der Benutzer das néchste Mal
seinen Code eingibt.



Datum und Uhrzeit einstellen Master/Manager

Damit die Prifung korrekte Ergebnisse liefert, ist es wichtig,
dass Datum und Uhrzeit jahrlich neu eingestellt und nach einem
Stromausfall von mehr als ein paar Minuten geprift werden.

Befehlsmenii > Geben Sie eine giiltige Benutzer-ID und einen
gultigen Benutzercode ein
> Time/Date > Set Time Date

Auf dem Display werden die aktuelle Uhrzeit und das Datum
angezeigt.

¢ Drlcken Sie die Eingabetaste.
e Geben Sie die neuen Werte in dem angezeigten Format ein.
Das Datum startet mit YY fur Year (Jahr).

Master/Manager

Zeitverzogerungswerte éindern

Die Zeitverzégerung ist eine Funktion, bei der eine bestimmte
Zeitspanne vergehen muss, bevor das Schloss gedffnet werden
kann. Dadurch wird verhindert, dass der Benutzer gezwungen wird,
den Tresor oder den Tresorraum unmittelbar zu éffnen.

Befehlsmenii > Geben Sie eine giiltige Benutzer-ID und einen
gultigen Benutzercode ein
> System > Locks > Time delay > Configure Times

e Wahlen Sie Delay period aus.

e Geben Sie mit zwei Ziffern die Zeitverzégerung an
(00-99 Minuten).

¢ Wadhlen Sie Confirm window aus.

o Geben Sie mit zwei Ziffern das Offnungszeitfenster an
(01-60 Minuten).

Die Zeitverzégerungswerte kénnen jederzeit verringert oder die
Zeitverzdgerung aufgehoben werden. Es muss allerdings ein
vollstandiger Zyklus (Zeitverzégerung, Schloss offen) mit den
vorherigen Einstellungen erfolgen, bevor die neuen Einstellungen
wirksam werden. Um die Zeitverzédgerung aufzuheben, geben Sie
00 fir die Verzégerung und 01 fir das Offnungszeitfenster
(Bestdatigungsfenster) ein.

Zahlung der Zeitverzégerung beenden Alle

Wenn eine Zeitverzégerung eingeleitet wurde, aber nicht mehr
bendtigt wird, kann sie abgebrochen werden.

¢ Drlcken Sie eine beliebige Taste, um das Display zu aktivieren.

¢ Drlcken Sie eine beliebige Taste, um den Codeeingabe-Bildschirm
aufzurufen.

e Geben Sie eine gultige ID und, wenn Sie dazu aufgefordert
werden, den Code ein.

¢ Wadhlen Sie Cancel TD aus.

Fehlerbehebung
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Bei Fehlern bei der Code- oder Befehlseingabe:
Drucken Sie die Rautetaste, um den Vorgang abzubrechen.

Das Schloss reagiert nicht:

Die Batterien sind moglicherweise leer. Wechseln Sie die Batterien
und stellen Sie danach Datum und Uhrzeit ein, damit die Prifung
genaue Ergebnisse liefert.

Die Tiir des Tresors oder Tresorraums lasst sich nicht 6ffnen:

Wenn das Schlosssystem ansonsten normal funktioniert, liegt
moglicherweise ein mechanischer Fehler am Tresor vor. Wenden Sie
sich an einen Techniker.

Menlustruktur

Master | Manager Benutzer

Schloss 6ffnen 4 v
v v
v

Change Combo
Time / Date...
> Time Format
> Date Format
> Set Time Date
> Observe DST
Audits...
PC Link
Users...
> Add...
> Open Priv
> Audit Priv
> TDO Pin Priv
> Add User
> Edit ...
> Status

v/ *wenn berechtigt

v/ *wenn berechtigt

> Reset Combo

CLLRLLCRLCLRCKLCKRAN

> Privileges
> User Type
> Delete...
System...
> Sys Info...
> Entry

LK

> Lock

> Backlight

> Buzzer

> TD cnt Mode...
> Delay Period

CLOLLCCKA

> Confirm Window
> Combinations
> Combo Length
> Force Combo Change
> User Mode
> Duress Mode
> Input Signal

<

> Locks...
> Uninstall
> Time Delay...
> Configure Times...
> Delay Period

LK

> Confirm Window
> Change Override
> Reset
> FW Update

Dokumentversion

Diese Anleitung wird regelmdBig aktualisiert. Die jeweils aktuelle
Version finden Sie auf unserer Website.
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Anhang B

Einfache Einrichtung
702 mit 1 Manager/1 Standardbenutzer/sechsstelligem Code
Tipps zur Navigation

e Jeder Tastendruck aktiviert das System. In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht
erforderlich ist, signalisiert das Schloss mit einem kurzen roten Blinksignal () und einem niedrigen Signalton «, dass das Schloss die
Eingabetaste ignoriert und auf Ihren Rautetasten-Befehl wartet.

e Bei Betdtigen der Rautetaste wdhrend einer Befehlssequenz wird die Sequenz abgebrochen.

¢ Eine neue Befehlszeichenfolge muss durch Eingabe von ID und Code begonnen werden.

. ° Bei Betdtigen der Eingabetaste werden im Allgemeinen die vorherigen Tastenfolgen Gbertragen.

e Auf einen erfolgreichen Rautetasten-Befehl folgt eine Antwort mit () )

¢ Auf einen fehlgeschlagenen Rautetasten-Befehl folgt eine Antwort mit ( . O 0,

¢ Die Kontrollleuchte bleibt wéhrend der Eingabe eines Rautetasten-Befehls griin. Diese Leuchte schaltet sich aus, wenn der Befehl
abgebrochen oder abgeschlossen wurde.

Befehle zur erstmaligen Einrichtung (fir 1 Manager/1 Standardbenutzer)

In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht erforderlich ist, signalisiert das Schloss mit
einem kurzen roten Blinksignal und einem niedrigen Signalton, dass das Schloss diese Taste ignoriert und auf lhren Rautetasten-Befehl wartet.

Die unten dargestellten Prifereignisse werden bei 701-Modellen nicht aufgezeichnet.

Aktion Befehlszeichenfolge Ergebnis

Offnen Sie das Wertbehdltnis mit dem werkseitig eingestellten Offnungscode ,1". Wéhrend der Ausfiihrung dieser Befehle zur Einrichtung muss das
Wertbehdltnis offen bleiben.

Schritt 1 Vorkonfigurierten - I - ISIGIGFDEDLDIE Tastatur: () (0 () ) €0) €)
Mit vorkonfiguriertem Manager hinzufliigen: #50
Benutzer installieren _Schlo§s: Mit aktiviertem Manager-Benutzer 01
Master-Code éndern: #52 @ #52 00 (ID) 12345678 (Code) installiert, Code = 123456, Berechtigungen:
00(D) _ _ _ _ _ _ __ Benutzer sollten den Code bei der erstmaligen
(neuer achtstelliger Code) Verwendung éndern.
00Dy _ _______ (neuer Code) @ Prifung: Ereignis 5 und 14 aufgezeichnet.
Schloss installieren: #22 @ [#22]+[00] + [achtstelliger Code] @
(D) 1) ) )
Schritt 2 Standardbenutzer mit Standardbenutzer Tastatur: ( O ) 1) 1)
.Nur 6ffnen” hinzufligen: o #50 00 02 123456 2 1 o
#50 Berechtigung_ “Nur offhen” Schloss: Neuer Benutzer mit Berechtigung zum
" Offnen, Benutzer sollten den Code bei der
erstmaligen Verwendung éndern.
Prifung: Ereignis 14 aufgezeichnet.
Schritt 3 Manager-Code éndern: @) #52 01(ID) 123456 (Code) Tastatur: () () () ) 2) 4)
Code: c;‘rlldern #52 01(D) _ _ ____ (neuer sechsstelliger Code) Schloss: Code gedndert
(empfohlen) 01Dy _ _ _ _ _ _ (neuer Code) ’ '
Prifung: Ereignis 14 aufgezeichnet.
§t%"d°figgnutzerc°de © #52 02 (ID) 123456 (Code) Tastatur: () () () o) ) 4)
andern: .
02(D) _ _ __ _ _ (neuer sechsstelliger Code) Schloss: Code gedndert.
02(D) _ _____ (neuer Code) @

Prifung: Ereignis 14 aufgezeichnet.




Einstellungen weiterer Systemfunktionen

In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht erforderlich ist, signalisiert das Schloss mit
einem kurzen roten Blinksignal und einem niedrigen Signalton, dass das Schloss diese Taste ignoriert und auf lhren Rautetasten-Befehl wartet.

Die unten dargestellten Prufereignisse werden bei 701-Modellen nicht aufgezeichnet.

Aktion Befehlszeichenfolge Anforderung Ergebnis
Codelénge @#oowd) ________ (Code) 6 @ fir 6 Stellen Nur Master Tastatur: (. D ) ) )
festlegen/ . f is-
éndern: #11 ©#1ooD) ________ (Code) 7 @ fur 7 Stellen Hinweis: Schloss: Codelénge fir Manager und
. Auswirkung auf Standardbenutzer gedndert
Q #1100(ID) _ _ _ _ _ _ __ (Code) 8 O flr 8 Stellen vorhandene
Benutzercodes Hinweis: Master-Codelénge (8 Zeichen) wird nicht
@ #nooWD) ________ (Code) 9 @ fir 9 Stellen geéndert. Andern der Codeldnge wirkt sich auf
vorhandene Benutzercodes aus.
*VVerwenden Sie den Moster—CQde,
um Benutzercodes nach einer Anderung der
Codeldnge zuriickzusetzen. Benutzer sollten
anschlieBend ihren Code bei der erstmaligen
Verwendung éndern.
Priifung: Ereignis 31 aufgezeichnet.
Code-Anderung  ,Code-Anderung erzwingen” Ein/Aus: Nur Master Tastatur: () () () ) @) 0)

erzwingen
einstellen

#17 (Standard: Aus)

Code-l'\nderung nicht erzwingen: O #17 00 (ID)

Schloss: ,Code-Anderung bei der ersten
Verwendung erzwingen” ist dann Ein/Aus.

Priifung: Ereignis 46 aufgezeichnet.

Summer ein-/ @#1 __(D) ________ (Code) 0 @ fiir Summer Aus ~ Master oder Tastatur: D ) ) )
ausschalten: #41 Manager )
Q #41 __ (D) _ _ _ _ _ ___ (Code) 1 ° far Summer Ein Schloss: Summer ein-/ausgeschaltet.

Port fiir © #99 (D) (Code) @ Master oder Tastatur: () () () d) €) €)

FW-Aktualisie- - T T T Manager

rung aktivieren: Schloss: Firmware kann durch Software der

#99 700er-Serie aktualisiert werden.
Priifung: Ereignis 37/38 aufgezeichnet.

PC Link 6ffnen: @#30 __D) ________ (Code) @ Master, Manager  Tastatur: () () () 4) 4) )

#30 oder Benutzer mit  Gyriine LED blinkt bei Dateniibertragung.

Berechtigung

Schloss: Kann durch Software konfiguriert werden.
Priifung: Ereignis 33 und 34 aufgezeichnet.
Hinweis: 702-Modelle unterstttzen ,PC Link" >
.Compare", Funktionen fir Programmierung und
Prifung bei 701 nicht verflgbar.

Hintergrundbe- @ 440 __ (D) __ _ _____ (Code) 0 @ fir Aus Master oder Tastatur: () () () ) ) )

leuchtung ein-/ Manager ) .

ausschalten: #40 @ #40 _ _(ID) _ _ _ _ _ _ _ _ (Code) 1 @ fir Ein (nur 702) Schloss: Hintergrundbeleuchtung ein-/

(nur 702) ausgeschaltet.

Lokale Uhrzeit 465 __ (D) __ _ (Code) JIMMTT HHmm @ Master oder Tastatur: () () () ) €5) €)

einstellen: #65 Manager

(nur 702) J3=Jahr, MM=Monat, TT=Tag, HHmm=Stunde/Minute (nur 702) Schloss: Uhrzeit eingestellt.

(24 Stunden)

Priifung: Ereignis 2 aufgezeichnet.

Zeitverzégerung
aktivieren/
deaktivieren/
dandern: #72

(nur 702)

Zum Aktivieren: #72 _ _(ID) _ _ _ _ _ _ _ _ (Code) XX YY @

XX=Verzégerungsdauer 1-99 Minuten, YY=Bestdatigungsfenster

1-60 Minuten

Zum Deaktivieren: #72 _ _ (ID)

00=Verzdgerungsdauer Minuten,
01=Bestdtigungsfenster Minuten

________ (Code) 00 01 @

Master oder
Manager
(nur 702)

Tastatur: () () () @) ) )

Schloss: Zeitverzégerung ist mit ausgewdhlter
Verzdgerungsdauer und ausgewdhltem
Bestdtigungsfenster aktiviert oder deaktiviert.

Priifung: Ereignis 8 aufgezeichnet.

Hinweis: Nach dem Deaktivieren der
Zeitverzégerung oder Verkilrzen der
Verzdgerungsdauer wird die neu eingestellte
Zeitverzdégerung erst dann wirksam, wenn das
Schloss unter der vorherigen Anforderung an die
Zeitverzégerung gedffnet wurde.




Aktion Befehlszeichenfolge Anforderung Ergebnis
Umgehungder 473 oo (D) __ _ __ _ __ (Code) 1@ zum Aktivieren Nur Master Tastatur: () () () ) <) 4)
Zeitverzogerung  nd zulassen der TDO (nur 702) . . .
(TDO) zulassen: Schloss: Umgehung der Zeitverzdégerung ist
#73 (nur 702) #7300(D) _ _ _ _ ____ (Code) 0 @ zum Deaktivieren aktiviert/deaktiviert.

und Unterbinden der TDO Priifung: Ereignis 39/40 aufgezeichnet.
Eingangssignal #16 00(D) __ _ (Code) 0 @ Ignorieren Nur Master Tastatur: () () () ) €5) €)
konfigurieren: (nur 702) ) i ) )
#16 (nur 702) #16 00(D) _ _ _ _ _ _ _ _ (Code) 1 Q Fernsperre Schloss: Schloss reagiert auf Eingangssignal wie

angegeben.

Z:r’ Zoeci)tflg)zé_ggran_g_ - ——(Code) 2 ° Fernumgehung Priifung: Ereignis 43 aufgezeichnet.

#16 00(ID) _ _ _ _ ____ (Code) 3 Q Umgehung des

Vieraugen-Prinzips
Benutzermodus  #1p go(D) . _ (Code) 0 @ Einzelbenutzer Nur Master Tastatur: () () () ) €5) €)
festlegen: #12 (nur 702) .
(nur 702) #12 00(ID) _ _ _ _ _ ___ (Code) 1 Q Vieraugen-Prinzip, Schloss: Benutzermodus gemaB Auswahl

gilt nicht far Manager festgelegt.

#12 000D) _ _ (Code) 2 ° Vieraugen-Prinzip, Priifung: Ereignis 30 aufgezeichnet.

gilt fir Manager
Bedrohungsmo- 414 oo (D) _ _ _ _ _ _ __ (Code) 0 @ zum Deaktivieren Nur Master Tastatur: | 2 ) ) )
dus aktivieren/ (nur 702) o o
deaktivieren: #14  #14 00(ID) _ _ _ _ _ _ _ _ (Code) 1 Q zum Aktivieren Schloss: Bedrohungsmodus deaktiviert/aktiviert.

(nur 702)

Befehle zum Betrieb

In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht erforderlich ist, signalisiert das Schloss mit

einem kurzen roten Blinksignal und einem niedrigen Signalton, dass das Schloss diese Taste ignoriert und auf lhren Rautetasten-Befehl wartet.

Die unten dargestellten Prufereignisse werden bei 701-Modellen nicht aufgezeichnet.

Aktion

Befehlszeichenfolge

Anforderung

Ergebnis

Code dndern:
#52

@#52 __(D) ______ (Code)
__(UD) ______ (neuer Code)
__(UD) ______ (neuer Code) @

Master, Manager oder
Standardbenutzer, Codelénge 6-9
wie erforderlich

(Master erfordert 8)

Tastatur: () () () ) 49) 4)
Schloss: Code gedndert.

Priifung: Ereignis 14 aufgezeichnet.

Schloss 6ffnen
(Einzel-
benutzer)

Signal Bedrohung +1/-1 letzte Ziffer des Codes
(nur 702)

Alarmbox und Alarmkonnektivitdt fir stillen Alarm
erforderlich

Manager oder Standardbenutzer
mit Berechtigung

D)) )
Schloss: Wird gedffnet.

Tastatur: A

Priifung:

Ereignis 10 fur erfolgreiche Entriegelung
aufgezeichnet.

Ereignis 21, wenn mit TDO entriegelt.
Ereignis 23, wenn mit Bedrohungscode
entriegelt.

Ereignis 18 Riegel eingefahren
(Riegelschaltkontakt erforderlich).
Ereignis 19 Riegel ausgefahren
(Riegelschaltkontakt erforderlich).

Schloss 6ffnen
(Vieraugen-
Prinzip)

(nur 702)

Signal Bedrohung +1/-1 letzte Ziffer des Codes
(nur 702)

Alarmbox und Alarmkonnektivitdt fir stillen
Alarm erforderlich

Manager oder Standardbenutzer
mit Berechtigung

Tastatur: (. o) ) )

Schloss: Wird gedffnet.

Prifung:

Ereignis 10 fir erfolgreiche Entriegelung
aufgezeichnet.

Ereignis 21, wenn mit TDO entriegelt.
Ereignis 23, wenn mit Bedrohungscode
entriegelt.

Ereignis 18 Riegel eingefahren
(Riegelschaltkontakt erforderlich).
Ereignis 19 Riegel ausgefahren
(Riegelschaltkontakt erforderlich).

Zeitverzoge-
rung abbre-
chen: #74
(nur 702)

______ (Code) @

Master, Manager oder
Standardbenutzer

Verzdégerungsdauer muss aktiv
sein

AN TN

BLOLOLD)

Schloss: Bleibt geschlossen, Verzégerungsdauer
ist beendet, es wird kein Offnungszeitfenster
gestartet

Tastatur: (.




Befehle zur Benutzerverwaltung

In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht erforderlich ist, signalisiert das Schloss mit
einem kurzen roten Blinksignal und einem niedrigen Signalton, dass das Schloss diese Taste ignoriert und auf lhren Rautetasten-Befehl wartet.

Die unten dargestellten Prufereignisse werden bei 701-Modellen nicht aufgezeichnet.

Aktion Befehlszeichenfolge Anforderung Ergebnis

Standard- Nur &ffnen: @ #50 (ID) (Code) Master oder Manager Tastatur: () () () ) 49) )

benutzer T N -

hinzufiigen: #50 — — (neuelD) _ _ _ _ __ (neuer Code) 21 @ Codeldnge muss Anforderung  gchloss: Neuer Benutzer mit angegebenen

erflllen Berechtigungen, Benutzer sollte den Code

(Code) bei der erstmaligen Verwendung dndern.

Nur Prifung: @ #50 _ _ (ID)

__(neuelD) _ _ _ ___ (neuer Code) 22 @
Priifung: Ereignis 14 aufgezeichnet.
Offnen + Prifung: @ #50 _ _(ID) _ _ _ _ _ _ (Code)
__(neuelD) _ _ _ _ _ _ (neuer Code) 2 3 Q
Offnen+TDO: @ #50 _ _(ID) _ _ _ _ _ _ (Code)
__(neuelD) _ _ ____ (neuer Code) 25 Q
Offnen +Prifung +TDO: @ #50 _ _(ID) _ _ _ _ _ _ (Code)
__(neuelD) _ _ _ ___ (neuer Code) 27 @
Manager- Nur &ffnen: @ #50 00(ID) _ _ _ _ _ _ _ _ (Code) Nur Master Tastatur: () () () ) €) €)
Benutzer
hinzufiigen: #50 — — (neuelD) _ _ _ _ __ (neuer Code) 41 @ Manager muss durch Master  gehloss: Neuer Benutzer mit angegebenen
erstellt werden Berechtigungen, Benutzer sollte den Code

Nur Prifung: @ #50 00 (ID) (Code)

Codeldnge muss Anforderung ~ bei der erstmaligen Verwendung andern.

__(neuelD) _ _ _ ___ (neuer Code) 4 2 =
© erflllen Priifung: Ereignis 14 aufgezeichnet.
Offnen + Prifung: @ #50 00(ID) _ _ _ _ _ _ _ _ (Code)
__(neuelD) _ _ _ __ _ (neuer Code) 4 3 Q
Offnen+TDO: @ #50 00(ID) _ _ _ _ _ _ _ _ (Code)
__(neuelD) _ _ ____ (neuer Code) 45 Q
Offnen + Priifung + TDO: @ #50 00 (ID)
________ (Code) _ _ (neue ID)
______ (neuer Code) 47 @
Benutzer @4 __(D) ______ (Code) _ _ (zu éndernder Master oder Manager Tastatur: () () () ) €) )
ZZEKL?\:;?;; Benutzer) 0 o zum Deaktivieren des Benutzers Manager muss durch Master  gchloss: Benutzer aktiviert/deaktiviert.
#54 . verwaltet werden
o #54 _ _ (D) _ _ _ _ __ (Code) _ _ (zu adndernder Priifung: Ereignis 14 aufgezeichnet.
Benutzer) 1 @ zum Aktivieren des Benutzers
Benutzer- Nur 6ffnen: @ #55 (ID) (Code) Master oder Manager Tastatur: () () () ) #) o)
berechtigungen . I S )
beqrbeitgn: 355 - — (zu &ndernder Benutzer) 1 @ Manager-Berechtigungen Schloss: Benutzerberechtigungen wie
g‘“sssrftd;‘mh ZAGSte" angegeben gedndert.
i . earbeitet werden
Nur Pruf“ung. o #55 __(D) ______ (Code) Priifung: Ereignis 14 aufgezeichnet.
_ _ (zu dndernder Benutzer) 2 o
Offnen + Prifung: @ #55 _ _(ID) _ _ _ _ _ _ (Code)
_ _ (zu &ndernder Benutzer) 3 °
Offnen+TDO: @ #55 _ _(ID) _ _ _ _ _ _ (Code)
_ _ (zu &ndernder Benutzer) 5 0
Offnen + Prifung + TDO: @) #55 _ _ (ID)
______ (Code) _ _ (zu &ndernder Benutzer) 7 o
anutzer @ #56 __(D) ______ (Code) _ _ (zu léschender Master oder Manager Tastatur: () () () ) €) €)
[ (28000 Benutzer) Manager muss durch Master 5
N Schloss: Benutzer geldscht.
geldscht werden
Priifung: Ereignis 14 aufgezeichnet.
Benutzercode @) 57 (ID) (Code) Master oder Manager Tastatur: () () () ) 4) )
zuriicksetzen: ckzusetzende ID)
#57 - (zurtfckzusetzende D) - (neuer Code) o Manager muss durch Master  gchloss: Benutzer erhdlt neuen Anfangscode,
_ _ (zurlickzusetzende ID) _ _ _ _ _ _ (neuer Code) zurlickgesetzt werden Benutzer sollte den Code bei der erstmaligen

Codeldnge muss Anforderung ~ Verwendung éndern.
erflllen Priifung: Ereignis 14 aufgezeichnet.




Tastatur und Schloss deinstallieren/erneut installieren/zuriicksetzen

In den folgenden Befehlen dient ° als Tastendruck zum Aktivieren des Systems. Wenn dies nicht erforderlich ist, signalisiert das Schloss mit
einem kurzen roten Blinksignal und einem niedrigen Signalton, dass das Schloss diese Taste ignoriert und auf lhren Rautetasten-Befehl wartet.

Die unten dargestellten Prufereignisse werden bei 701-Modellen nicht aufgezeichnet.

Aktion

Befehlszeichenfolge

Anforderung

Ergebnis

:I'astqt.ur erneut ° #32 __ (D) _ _ _ __ _ (Code) ° Berechtigung zum Offnen qutq'tur: Abwe_chselnd rote und griine
installieren: #32 erforderlich Blinksignale zeigen an, dass dasselbe
Tastaturmodell nicht gekoppelt wurde.
Erfolg wird angegeben mit | - 2 ) ) €)
Schloss: Schloss ist installiert (mit Tastatur
gekoppelt).
Prifung: Ereignis 17 aufgezeichnet.
Zchlotss“. ° #23000D) __ (Code) ° Nur Master Tastatur: () () () ) 4) )
einstallieren:
#23 Schloss: Ist nicht mehr installiert (mit Tastatur
gekoppelt), alle Einstellungen bleiben erhalten.
Prifung: Ereignis 11 aufgezeichnet.
Sch!ois . @5 00(D) ________ (Code) @ Nur Master BIGIDLDLD)
zurlicksetzen:
#25 Schloss: Master-Code auf 12345678
zurlickgesetzt, alle Benutzer geldscht,
alle Werkseinstellungen wiederhergestellt,
Schloss wird deinstalliert
(von Tastatur entkoppelt).
Priifung: Ereignis 4 aufgezeichnet.
§chlo§s ° #22 00(D) _ _ _ _ _ _ _ _ (Code) ° Deinstalliert: Tastatur: ":,“ﬁ:\ ‘f:,‘ o) () )
installieren: #22 Der Master-Code wurde
von der Schloss: Installiert.
Standardeinstellung Priifung: Ereignis 5 aufgezeichnet.
gedndert.
Kundendienst
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LA GARD 700 Basic

Bedienungsanleitung

DIN-links und -rechts verwendbar, Schwenkriegel oder Sperrriegel

Kompatibilitét und Identifizierung

e Tastaturen und Schlésser des 700 Basic-Modells sind nicht mit
Schléssern und Tastaturen der 700er-Serie oder dlteren LA GARD-
Produkten kompatibel.

Tastaturen und Schlésser des 700 Basic-Modells sind mit folgender
Software und folgendem Zubehér fir die 700er-Serie kompatibel:

— Resetbox fiir die 700er-Serie (Teilenummer 704065)

— Spannungsversorgung fur die 700er-Serie (Teilenummer 701131)

— Software fir die 700er-Serie, nur zur Firmware-Aktualisierung

— USB-Dongle fir die 700er-Serie (Teilenummer 707040)
USB-auf-Mini-USB-Kabel fiir die 700er-Serie (Teilenummer 203325)
Driicken Sie zur Identifizierung eines LA GARD Basic-Modells die Rautetaste.
Bei Tastaturen des 700 Basic-Modells schaltet die Hintergrundbeleuchtung
ein, das Schloss reagiert aber nicht auf diesen Befehl.

Hinweis: Bei den Modellen 701-705 leuchtet die LED grin.

Benutzeraktionen

Benutzeraktionen Super Master Reset Code (optional) Manager Benutzer
Schloss zuriicksetzen Ja Nein Nein
Schloss 6ffnen Nein Ja Ja
Eigenen Code éndern w» Ja Ja
Benutzer aktivieren/wiederherstellen Nein Ja Nein
Benutzer deaktivieren Nein Ja Nein
Benutzer l6schen Nein Ja Nein
Firmware-Aktualisierung (erfordert Nein Ja Nein

Verbindung zur Software der 700er-Serie)

% Vor dem Andern des Master-Codes muss der voreingestellte Super Master Reset Code gedndert werden. Der Code kann nur zu diesem
Zeitpunkt festgelegt werden. Ist der Code einmal festgelegt, kann er nicht mehr geéindert werden. Wird der Code nicht zu diesem
Zeitpunkt festgelegt, steht die Funktion Super Master Reset nicht zur Verfliigung.

Betrieb des Schlosses und Navigation
 Geben Sie zum Offnen des Schlosses den sechsstelligen Code ein.
¢ Das Schloss muss nach Eingabe eines giltigen Codes innerhalb von 4 Sekunden gedffnet werden.

e Um ein Wertbehdltnis mit einem Schwenkriegelschloss zu éffnen, drehen Sie den Griff am Wertbehdltnis in die gedffnete Position und
6ffnen Sie die Tar.

e Um ein Wertbehdltnis mit einem Sperrriegelschloss zu 6ffnen, drehen Sie die Tastatur oder den Drehknopf, um den Riegel zurlickzuziehen
und die Tur zu 6ffnen.

Achten Sie beim VerschlieBen eines Wertbehdltnisses darauf, dass es sicher verschlossen ist.
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e Um einen Befehl zum Schlossbetrieb einzugeben, geben Sie den sechsstelligen Code ein und halten Sie die letzte Ziffer 3 Sekunden lang
gedrlckt, bis die Tastatur mit @s reagiert und die LED dauerhaft leuchtet.

Wenn Sie bei der Eingabe eines Codes oder Befehls einen Fehler machen, warten Sie 30 Sekunden und wiederholen Sie den Vorgang.

Ein doppeltes Signal (" bedeutet, dass der Code oder Befehl gultig ist und akzeptiert wurde.

Ein dreifaches Signal ( .z bedeutet, dass der Code oder Befehl unglltig ist.

Der voreingestellte Super Master Reset Code (SMR) 55555555 muss vor dem Andern des Manager-Codes gedndert werden. Andernfalls
steht die Option SMR nicht zur Verfigung. Nachdem der Super Master Reset Code festgelegt wurde, kann er nicht mehr gedndert werden,
es sei denn, das Schloss wird mit einer kompatiblen Resetbox zurlickgesetzt.

Installation

Die Montageanleitung finden Sie im Quick Start Guide oder im Safe Lock Installation Guide fur die LA GARD 700er-Serie. Das Schloss muss
montiert und mit der Tastatur verbunden werden, bevor Sie es an die Spannungsversorgung anschlieBen oder Batterien einlegen.

1. Installieren Sie die Tastatur.
2. Installieren Sie das Schloss.
3. SchlieBen Sie die Tastatur an den ENT-Anschluss des Schlosses an.

4. Legen Sie Batterien ein und/oder schlieBen Sie das Schloss an die Spannungsversorgung an. Das Schloss bestdatigt, dass es
betriebsbereit ist. () «) Offnen Sie das Schloss mit dem Manager-Code 123456.

Hinweis: Wenn die Tastatur an die Spannungsversorgung angeschlossen ist und innerhalb von 10 Sekunden kein Schloss erkannt wird, gibt
die Tastatur ein Fehlersignal aus. (.« x 5

Sobald die Verbindung zwischen Schloss und Tastatur wiederhergestellt ist, bestdtigt die Tastatur, dass sie betriebsbereit ist. (.)€
Driicken Sie eine beliebige Zifferntaste, um die Verbindung erneut zu testen.

Schnellstart: 1 Manager/1 Benutzer/Super Master Reset Code

Flhren Sie Programmiervorgdnge immer bei offenem Wertbehdltnis aus. Testen Sie jeden Benutzercode vor dem VerschlieBen des
Wertbehdltnisses.

1. Super Master Reset Code dndern ,0"-Taste 3 Sekunden lang gedriickt halten ( v"lm Der Super Master Reset
(optional) Standardcode 55555555 elngeben und die letzte Ziffer 3 Sekunden lang Code kann nun verwendet
gedrickt halten | ) werden.
LED leuchtet douerfloft.
Taste ,0" driicken ()%
Neuen achtstelligen Code eingeben (% _
Neuen achtstelligen Code erneut eingeben ()%
LED schaltet sich aus
2. Code dndern (empfohlen) Wertbehdltnis 6ffne_n Der Manager-Code wurde
000000 eingeben (. geéndert.
Standardcode 123456 eingeben (.
LED leuchtet dauerhaft. _
Neuen Code eingeben (z. B. 654321) s
Neuen Code erneut eingeben (z. B. 654321) :)13
Code vor dem VerschlieBen des Wertbehdltnisses testen
LED schaltet sich aus
3. Benutzer aktivieren — Befehl 1 Den neuen Monoger Code eingeben und die letzte Ziffer 3 Sekunden lang Der neue Benutzer ist nun
(optional) gedrickt halten | e aktiv und kann seinen Code
LED leuchtet douerhqft verwenden.

Taste ,1" driicken ()<

Code des neuen Benutzers eingeben ®x _
Code des neuen Benutzers erneut eingeben :,—:‘313
Code testen

LED schaltet sich aus




Schlossbetrieb

Vorgang

Aktion

Anforderung

Ergebnis

Super Master Reset
Code festlegen

,0"-Taste 3 Sekunden lang gedriickt halten ®s
Standardcode 55555555 elngeben und ¢ d|e letzte Ziffer
3 Sekunden lang gedriickt halten © p
LED leuchtet dauerhaft.

Taste ,0" driicken ()% R

Neuen achtstelligen Code eingeben ()%
Neuen achtstelligen Code erneut eingeben @
LED schaltet sich aus

Einrichtung. Muss durchgefihrt

werden, bevor der Manager
seinen Code dndert.

Der Super Master Reset Code
kann nun verwendet werden.

Schloss 6ffnen

o

Aktiven Code eingeben -»
Wertbehdltnis 6ffnen

Manager oder Benutzer

Das Schloss ist gedffnet.
Der Riegel kann innerhalb von
4 Sekunden eingefahren werden.

Code dndern

Es wird empfohlen, diesen Vorgang bei geéffnetem
Wertbehdltnis durchzufiihren.

Methode 1: _

000000 eingeben (% ~
Bisherigen Code eingeben (z. B. 123456) ()%
LED leuchtet dauerhaft. _

Neuen Code eingeben (z. B. 654321) @) _
Neuen Code erneut eingeben (z. B. 654321) ()4
LED schaltet sich aus

ODER

Methode 2:

Bisherigen Code eingeben (z. B. 123456) D|e letzte Ziffer
3 Sekunden lang gedriickt halten
LED leuchtet dauerhaft.

Taste ,0" dricken

Neuen Code eingeben (z. B. 654321) ®:a
Neuen Code erneut eingeben (z. B. 654321) [ .«
LED schaltet sich aus

Code vor dem VerschlieBen des Wertbehdltnisses testen.

Manager oder Benutzer

Der Code wurde gedndert.

Benutzer aktivieren
Befehl 1

Manager-Code emgeben und die letzte Ziffer 3 Sekunden lang
gedriickt hatten (. )e( 3
LED leuchtet douerhaft.
Taste ,1" driicken ()% _

Code des neuen Benutzers eingeben @ _
Code des neuen Benutzers erneut eingeben D
Code testen

LED schaltet sich aus

Manager

Der neue Benutzer ist nun aktiv
und kann seinen Code
verwenden.

Benutzer deaktivieren
Befehl 2

Manager-Code elngeben und die letzte Ziffer 3 Sekunden lang
gedriickt halten (% ()
LED leuchtet douerrlaft.

Taste 2" drlicken (

LED schaltet sich aus

Manager

Der Benutzer ist deaktiviert.
Der Code wird aufbewahrt,
ist aber nicht aktiv.

Benutzer
wiederherstellen
Befehl 1

Manager-Code elngeben und die letzte Ziffer 3 Sekunden lang
gedriickt halten ( “
LED leuchtet douerhoft
Taste 1" dricken Jes
LED schaltet sich aus

Manager

Der deaktivierte Benutzer ist aktiv
und kann seinen bisherigen Code
verwenden.

Benutzer l6schen
Befehl 3

Manager-Code elngeben und die letzte Ziffer 3 Sekunden lang
gedriickt halten ( Jo

LED leuchtet dauerhaft.

Taste ,3" driicken ()%

LED schaltet sich aus

Manager

Der Benutzer wird geldscht.
Der Code wird geldscht.

Schloss mit Super
Master Reset Code
zuriicksetzen

,0"-Taste 3 Sekunden lang gedrickt halten © @
Super Master Reset Code eingeben und | dle letzte Ziffer
3 Sekunden lang gedrickt halten ]

Taste ,8" driicken ()<
LED schaltet sich aus

Der Super Master Reset Code
muss festgelegt sein.

Der Super Master Code éndert
sich nicht. Der Manager-Code
lautet 123456. Es ist kein
Benutzercode vorhanden.




Weitere Funktionen

Manipulationssperre
Nach viermalig aufeinanderfolgender falscher Eingabe wird eine finfminttige Manipulationssperre ausgelost.
Wadhrend der Sperre:
o Die LED der Tastatur blinkt alle 10 Sekunden.
 Die Tastatur reagiert nicht auf die Verwendung von Zifferntasten.
Nach Ablauf der finfminutigen Sperre wird nach zweimaliger falscher Eingabe erneut eine fiinfminttige Manipulationssperre ausgelost.
Dies wird so lange fortgesetzt, bis ein gulltiger Code eingegeben wird.

Schwache Batterie/Batteriewechsel
Es wird empfohlen, die Batterien einmal jahrlich auszuwechseln. Verwenden Sie nur hochwertige 9-Volt-Alkaline-Batterien.

Warnung bei schwacher Batterie: Bei der Offnung des Schlosses wiederholt die Tastatur das Signal finf Mal. ()¢ x5 Diese Warnung weist
darauf hin, dass die Batterie schwach ist und ausgetauscht werden sollte.
Warnung bei kritisch niedrigem Batteriestand: Die Tastatur wiederholt beim Driicken jeder beliebigen Taste das Signal zehn Mal. (¢ x 10

Diese Warnung weist darauf hin, dass das Schloss nicht sicher betrieben werden kann. Die Batterien missen ersetzt werden, um das Schloss
weiter benutzen zu kénnen.

Mechanisches Zurlicksetzen Uber die Resetbox
Ein mechanisches Zurlicksetzen kann Uber die LA GARD Resetbox (Teilenummer 704065) durchgefihrt werden. Bei einem Zurticksetzen mit der
Resetbox der 700er-Serie ldsst sich ein Schloss auf die Standardeinstellungen zurlicksetzen:
¢ Der Super Master Reset Code wird auf den Standardwert 55555555 zurlickgesetzt und muss vor dem Andern des Manager-Codes festgelegt
werden.
e Der Manager-Code wird auf den Standardwert 123456 zurlickgesetzt.
¢ Esist kein aktiver Benutzer vorhanden.
Nachdem die Resetbox an ein Tresorschloss angeschlossen wurde, kénnen geldschte Benutzer nicht wiederhergestellt werden.
Alle Einstellungen werden auf ihre Standardwerte zurlickgesetzt. Wéhrend die Resetbox mit dem Schloss verbunden ist, wird die GESAMTE
Kommunikation von der Tastatur abgelehnt. Der Zugang zum gesicherten Bereich MUSS gewdhrleistet sein (die Zugangstir offen halten),
bis die Verbindung der Resetbox zum Schloss getrennt wird. Wenn die Zugangstir geschlossen ist, muss das Schloss aufgebohrt werden.

Zuricksetzen (iber die Resetbox

1. Entfernen Sie die Batterien oder trennen Sie das Schloss von der Spannungsversorgung.

2. Halten Sie die ,0"-Taste 10 Sekunden lang gedriickt, um eventuellen Reststrom zu entladen.

3. SchlieBen Sie die Resetbox am BAT-Anschluss des Tresorschlosses an.

4. Die LED der Resetbox leuchtet flr etwa 3 Sekunden auf und erlischt, wenn das Zurlicksetzen abgeschlossen ist. Solange das Zurlicksetzen
nicht abgeschlossen ist, darf die Steckverbindung der Box nicht getrennt werden.

5. Trennen Sie die Verbindung von der Resetbox zum Tresorschloss.

6. Nach erfolgreichem Zurilicksetzen wird der Manager-Code auf die Standardeinstellung 123456 und der Super Master Reset Code auf die
Standardeinstellung 55555555 zurlickgesetzt.

7. SchlieBen Sie das Schloss wieder an die Spannungsversorgung an. Offnen Sie nun das Schloss zur Uberpriifung mit dem Manager-Code
123456.

Hinweis: Wenn die LED der Resetbox nicht aufleuchtet, trennen Sie die Resetbox und wiederholen Sie die Schritte 1und 2.

Firmware-Aktualisierung

Sobald eine neue Firmware verfligbar ist, werden diese Dateien den Benutzern der LA GARD-Software bereitgestellt. Mit dem LA GARD-Software-
Client kann die Firmware von Tastatur und Schloss aktualisiert werden. Zur Aktualisierung der Firmware des Schlosses und der Tastatur auf die
aktuelle Version bendtigt der Manager einen PC mit der Software der 700er-Serie, einen USB-Dongle flr die 700er-Serie (Teilenummer 7047040)
sowie ein USB-auf-Mini-USB-Kabel (Teilenummer 203325).

1. SchlieBen Sie die Tastatur an den PC an. Stecken Sie den USB-Dongle der 700er-Serie in den USB-Anschluss des PCs. Stecken Sie den
USB-Stecker des Kabels in den Dongle. Stecken Sie dann den Mini-USB-Stecker in den Anschluss an der Tastatur des Schlosses.

2. Geben Sie den Manager-Code ein und halten Sie die letzte Ziffer 3 Sekunden lang gedriickt. % LED leuchtet dauerhaft.

3. Driicken Sie die Taste ,6". (- LED leuchtet dauerhaft. Hinweis: Das Gerdt befindet sich etwa 60 Sekunden lang im Modus ,Firmware laden”.
Wahrend dieser Zeit ignoriert das Gerdt alle Eingaben Uber die Tastatur, um die Kommunikation zwischen der Software und dem Gerdt
aufrechtzuerhalten.

4. Verwenden Sie die Software, um die neueste Firmwaredatei flr das 700 BASIC auszuwdhlen und hochzuladen. Solange die Verbindung aktiv ist,
leuchtet die LED. Wird innerhalb von 60 Sekunden keine Verbindung hergestellt, wird der Vorgang abgebrochen und die LED erlischt. Nachdem
die Verbindung hergestellt wurde, blinkt die LED auf der Tastatur wdhrend der Aktualisierung griin.

5. Wenn die LED auf der Tastatur aufhért, grin zu blinken, bedeutet das, dass die Firmware-Aktualisierung abgeschlossen ist.




Hinweis: Schlésser und Tastaturen des 700 Basic-Modells sind nur mit der 700 Basic-Firmware kompatibel. Die 700 Basic-Firmware ist nicht mit
anderen Modellen der 700er-Serie kompatibel. Wird eine inkompatible Firmware ausgewdhlt, zeigt die Software der 700er-Serie einen Fehler an
und hdlt die Verbindung aufrecht, bis die kompatible Firmware ausgewdihlt wird. Wéihlen Sie zum Beheben des Fehlers die entsprechende
Firmware aus und schlieBen Sie die Aktualisierung ab.

Wird ein inkompatibler Befehl ausgewdhlt, leuchtet am Schloss gegebenenfalls eine rote LED bis zu 20 Sekunden lang auf. Wéhrend dieser Zeit
reagiert die Tastatur auf keine Tastendrilicke.
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